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e-.. . Supportive Tool for Assess

Growth in Educational

STAGES (Supportive Tool for Assessing Growth in Educational Systems) is a
comprehensive on-line tool for evaluating, reporting, and developing high quality
educational systems. Developed by Saginaw Valley State University in cooperation with
the Bay-Arenac ISD and supported by Zimco, Inc., this revolutionary web-based program
is based on Charlotte Danielson’s system for teacher evaluation. STAGES provides the
link between record keeping, information reporting, and strategy development that has
often been missing.

e |

UserName: I

Password: I

Login Now ! |

You will receive an automated e-mail notification when it is time to complete your Self-Evaluation that reads:

“This notice is to inform you that you are to complete a self evaluation within the next 10 days. Log on to
https://lwww.stagessoftware.com go to My Evaluations. Click on the current evaluation. Notice: DO NOT REPLY to this

automatically generated e-mail. Contact your supervisor directly with questions.”

Log In

1. Loginto STAGES on the internet at http://login.stagessoftware.com in the URL
2. Enter your Username and Password. Note: The password field is case sensitive.
3. If you do not have a UserName and Password contact Human Resources.
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Logout

Print |

Welcc?ne, Will Rogers | Logged in as Evaluatee

Dashboard My Evaluations My Profile

Before you begin the evaluation, click My Profile at the top center of the screen.

User Profile
Dashboard My Evaluations My Profile
User Profile
My Prafile
—MName
First Name: Will Last Name: Rogers
—Information

Evslustion Group: ID-':|11-:-HS--D-':m-:- High Sn:h-:--:-lj Education Level: If‘-;1:-|5t-':|‘5 vI
School Type: I vl Grade(s) I vI
| jv

Initigl Cartification - . - .
Ibaglnaw Valley State Univers j

Gender: | Male University:
Cartification: ;I
Ethnicity: |P‘J’|‘-:- American j
[
pected Level: |P|'.:.ﬁ.:i»:-_,|'|t j 7 Trsinzg Mentor
I_ Tenured

—Access
Assigned Login Name: wrogers@demaodistrict. ong

Fassword: Change Password

Review the information on your individual profile for accuracy. Report any discrepancies to Human Resources via e-mail.

To change your password, click on Change Password at the bottom of the profile screen and follow prompts.




To begin the evaluation, click My Evaluations at the top right of the screen.
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Welc:;ne, Will Rogers | Logged in as Evaluatee \

Dashboard Wy Evaluations MWy Profile

Print | Logout

My Evaluations

Name Due Date Open
Open

Will Rogers 04/29/2009 (Current |

Click the Open tab next to the most current date. (STAGES maintains a history file for all evaluations completed.)

Note: the Open New Window tab at the bottom of the screen allows the user to view their rubric in its entirety.

Assignad Rubric Review

Feview

Descriptions and Ratings: Open New Window




1) To view completed observations, click the View tab to the right of the observations.

Welcome, Jimmy Dean | Logged in as Teacher
My Evaluations | My Profile | Logout |

EVALUATION INFO

Personnel Info:
Jimmy Dean Date Action

Date Evaluation Due: 04/30/2009

SELF EVALUATION
o Self-Evaluation Record |

OBSERVATIONS All Due by: 6-17-2009
«” QObservation ggtmpleted
u Observation Locked
I “d Observation Locked
1) Click the Record tab to complete the Self-Evaluation using the drop down bars.



Individual Performance Evaluation

Self Evaluation for Rogers, Will . -
g Cancel, Back to Checklist | Expected Level: Proficient

Planning and Preparation

1. Knowledge of Content

[~ ]

. Knowledge of Students' Development and Skills

. Knowledge of Students' Interests. Cultures. and Varied Approaches to Learning

(4]

. Selection of Instructional Goals and Reflection within the Lesson Plan Geals:

4
5. Organization of Physical Space
5

. Health and Safety Safety Procedures:

K I K\ N N KR KN

Learning Environment

7. Interaction with Students

8. Student Interaction

9. Student Groups

10. Materials and Resources

11. Expectations and Directions

Ll el e ) e

12. Monitoring and Response to Student Behavior

Instruction

13. Oral and Written Language

14. Use of Resources

15. Use of Intructional Technigues

16. Activities and Assignments

17. Flexibility and Responsivenass

18. Feedback to Students

KN JEN | EN N | ER RN EY

15. Assessment of Student Learning

Classroom Management/Program Standards

20. Placement

21. Community Projects

22. Student Clubs

23. Advisory Committee

24, LEA

25. Articulation

26. Certification

K K KRR | RN K KN RN

27. Career Center Committeas




28. Technology | Proficient =l
29. Student Success Indicators [ Proficient |

Professional Responsibilities

30. Service to Students | Exemplary |
31. Service to Families | Proficient =l
32. Service to District [ Proficient =l
33. Service to Profession | Proficient |
34. Service to Self | Proficient =l
35. Maintain Confidentiality | Proficient =l
36. Work successfully and positively with others | Exemplary |

Save || Finished
Cancel, Bac ' /

Click the Save tab at th e screen to save your work and continue at a later date.
Click on the Finish tab at the bottom of the screen to save your work and Finalize the Self-Evaluation.




Welcome, Will Rogers | Logged in as Evaluatee

Dashboard My Evaluations My Profile

EVALUATION INFO

Personnel Info:

294 Will Rogers Date Action
: Date Evaluation Due: 04/29/2009

Q? Self-Evaluation 01/15/2010 View

&’ Status® Not Released To Evaluator Release |

Q? Observation 1 04/06/2009 Not Released

;% Observation 2 Available

I Observation 3 Locked

L ——

1) Click the Release tab to release your Self-Evaluation to your Supervisor.
Note: Once you have released the Self-Evaluation, you cannot un-release it.

2) Click the View Tab to the right of the Individual Performance Evaluation to view the
performance evaluation.

STAGES Assessment Report
Perfomance Evaluation for: Teacher Sally
Expected Level: Proficient
Planning and Preparation
Underdeveloped

¢ Knowledge of Content and Pedagogy
e Organization of Physical Space

Score: 40% of Planning and Preparation -- 8.3% of Total Eval
Developing
¢ Knowledge of Students' Development and Skills
Score: 20% of Planning and Preparation -- 4.2% of Total Eval
Proficient
o Knowledge of Students as Individuals
Score: 20% of Planning and Preparation -- 4.2% of Total Eval
Exemplary
e Selection of Instructional Goals
Score: 20% of Planning and Preparation -- 4.2% of Total Eval
Learning Atmosphere
Developing

e Teacher to Student Interaction
e Materials and Resources
e Expectations and Directions

Score: 42.9% of Learning Atmosphere -- 12.5% of Total Eval
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Proficient

Student to Student Interaction

Student Groups

Transitions and Pacing

Monitoring and Response to Student Behavior

Score: 57.1% of Learning Atmosphere -- 16.7% of Total Eval
Instructional Delivery

Underdeveloped

e Flexibility and Responsiveness
¢ Feedback to Students

Score: 28.6% of Instructional Delivery -- 8.3% of Total Eval
Developing
e Techniques for Questioning and Holding Discussion
Score: 14.3% of Instructional Delivery -- 4.2% of Total Eval
Proficient

e Activities and Assignments
e Assessment of Student Learning

Score: 28.6% of Instructional Delivery -- 8.3% of Total Eval
Exemplary

e Oral and Written Communication
e Use of Resources

Score: 28.6% of Instructional Delivery -- 8.3% of Total Eval
Professional Service
Underdeveloped
e Service to Families
Score: 20% of Professional Service -- 4.2% of Total Eval
Developing
¢ Service to Self
Score: 20% of Professional Service -- 4.2% of Total Eval
Proficient

e Service to District
e Service to Profession

Score: 40% of Professional Service -- 8.3% of Total Eval
Exemplary

e Service to Students

Score: 20% of Professional Service -- 4.2% of Total Eval
Total Score:
Exemplary: 16.7%
Proficient: 37.5%
Developing: 25%
Underdeveloped: 20.8%

From the Self-Evaluation drop down rating selections, the information is automatically organized in this format for your
Performance Evaluation.



Qf Individual Performance Evaluation 11/04/2009 View

Q? Individual Development Plan 11/04/2009 Edit

Q? Set Goals 08/05/2009 Edit

To view/add comments to your Individual Development Plan (IDP), click the View tab to the right of
Individual Development Plan.

Reports - Windows Internet Explorer o V= |
@:—: - Ie_" htips://zbs. zimco .net/program stages-demo evaluates_report.php J % 2| X IC—

Ele Edit WVew Favorites Tools Help

OF R e Reports | | 4 - B - o= - |5k page + (G Tooks -

-

Individual Development Plan: Jimmy Dean

Expected Level: Developing

Knowledge of Content Meets Expected Level Expected Level: Dizplays little understanding of important prerequisite
knowledge. Makss content errors. Uzes poor examples. Conveys a negative
attitude. Communicates that the content iz net impertant.

Objectives for Growth/Goals/Comments

The following comments wers added by: jdean@demedistrict.org on February 12, 2010 03:57 PM

thiz iz a sample

Knowledge of Students’ Development Meets Expected Level Expected Level: Dizplays general knowledge of developmental

and Ski characteristics or studsent skile/knowlsdgs, but only dizplays thiz knowledgs
as it pertaing te the whole class.

Objectives for Growth/Geals/Coemments

Knowledges of Students’ Intersats, Meets Expected Level Expected Level: Dizplays gensral understanding of student interests or

Cultures, and Varied Appreaches to cultural heritage. Demenstrates basic knowledge of different appreaches to

Learning lzarning, but views the clazs az a whole.

Objectives for GrewthiGoalz/Cemments

Selection of Instructional Goalz and Exceeds Expected Level Expected Level: Are mederately clear or suitable for mest students,

Reflection within the Lez=son Plan represent moderately valuable expectationz. Allow for some assesament.

Goals: Reflect several types of learning with no ffort at content integration.

Objectives for Growth/Geals/Coemments

Organization of Physical Space Exceeds Expected Level Expected Level: Iz suitable and accessible fer some learning activitiss.

Objectives for Growth/GoalsiComments

Health and Safety Safety Procedurss: Meets Expected Level Expected Level: Exizt, but no evidence of review or utilization.

Objectives for GrewthiGoalz/Cemments

Intsraction with Students Exceeds Expected Level Expected Level: Interactions with students are generalty appropriats, but
mav reflert necazinnal inconzirtencies favaritizm nr dizrenard for ztudents LI




The figure below is an example of the IDP. To add comments, click directly on the words Objectives for
Growth/Comments. =

Click the Close Butter-kax in the top-most right corner of THIS screen to get back to the Evaluation
Information menu.

Individual Development Plan: Jimmy Dean
Expected Level: Developing

Knowledge of Content Meets Expected Level Expected Level: Dizplays little understanding of important prereguisite
knowledos, Makes content errers. Uses poor examples. Cenveys a negative
. . tent iz not impertant.
_— To add comments, click directly on the words TE R e mearan
Obijectives for Growth/Goals/Comments ‘ Objectives for Growth/Comments.

The follewing cemments wers added by jdean@demANETICLOTY O TETUATY 1<, 2070 U3 57 Pl
thiz iz a =ample

Knowledge of Studentz’ Development Meets Expected Level Expected Level: Dizplays general knowledge of developmental
and Skillz characteristics or student skills/knowledge, but only digplays thiz knowledge

az it pertainz to the whole clazs.

Objsctives for GrowthiGeals/Comments

Knowledge of Students’ Interests, leets Expected Level Expected Level: Dizplays general understanding of student interests or
Cultures, and Varied Approaches to cultural heritage. Demonstrates basic knowledge of different approaches to
Learning lzarning, but views the clazs az a whole.

Obijectives for Growth/Geals/Comments

Selection of Instructional Goale and Exceeds Expected Level Expected Level: Are mederately clear or suitable for mest students,
Reflection within the Les=on Plan represent moderately valuable expectations. Allow for 2ome azzessment.
Gerale: Reflect eeveral types of lzarning with no effort at content integration.

Obijectives for Growth/Geals/Comments

Organization of Physical Space Exceeds Expected Level Expected Level: Iz suitakle and accessitle for some learning activities.

T P P

Qrientaticn MNight.

Objectives for Growth/Geals/Cemments

Articulation lMeets Expected Level Expected Level: Teacher purzues articulation agreements with colleges o
not applicable. Articulatien agreements are not applicable at this time.

Objectives for Growth/Goals/Comments

Certification Meets Expected Level Expected Level: Teacher has integrated the certification objectives into th
curriculum. Teacher and students meet all certification criteria that i= availat
and test for cerification. Certification not appplicakble at this time.

Objectives for Growth/Geals/Cemments

Building Specific Committzez lMeets Expected Level Expected Level: Teacher dizplays a general understanding ef hiz/her add
value to cur Building committees and the importance of committes work to tt
success of our School Teacher iz minimalty invebeed in Building committees
Involvement in committees iz non-active or limited to a participation status.

Objectives for Growth/Geals/Cemments

Technelegy Exceeds Expectied Level Expected Level: Teacher dizplays a general understanding of the
importance of technolegy in higther clazsreom. Teacher demonstrates a ba
understanding of technology and computer applicationz. Some attempts to
integrate technology applicationz into the curriculum are being made.

Objectives for Growth/Goals/Coemments

Student Succeszs Indicators Exceeds Expected Level Expected Level: Teacher haz general understanding of Student Success
pregram. Promotes some of the Student Success Indicators with students
throughout the year.

Objectives for Growth/Goals/Comments

IDP Finished |
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Objective Editor

Learning Environment
Expectations and Directions

This is & place f£o0r CONMENTS =] Enter vour comments in the text area to the left. then click the "Next" button t
proceed.

=l
Follow the instructions to add your comments and click the NEXT button.

Note: Itis not necessary to add comments to each objective.

EVALUATION

Q? Individual Performance Evaluation 11/04/2009 View

Q? Individual Development Plan 11/04/2009 Edit

Q? Set Goals 08/05/2009 Edit

Click the Edit tab to the right of Goals to review the goals.

Goals

Complete the Projected Activities, Expected Outcome, Timelines, and Progress Indicator.
Click the Add This New Goal button once you have completed Goal 1.
Space will appear for Goal 2 and so on each time you click the Save tab.

Goals

SELECT * FROM thlgoals WHERE evalwfid = '629° CRDER BY goalnum

+ Coal #1: goal 1 - attend conference

Projested Activities Expected Outcomes Timelines Progress Indicator

Aftend one technolothywcgnference |Implement new technology for June 2010 Posted course online.
online systems in classroom

¢ Add Goal 2

To change a goal or add information, click on the pencil icon next to the “Goal #” to be changed and make the changes.
Click the Update tab once data has been entered.
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Goals
n Expected Outcomes Timelings Progress Indicator
=l - - -
= [~ [ [~

Add This New Goal |

Click the Close button to return to the Evaluation Process Checklist.

Evaluatee Signature

L 4 N N

Evaluator Signature

Finished

v MU?\S/ Clear

NEXT EVALUATION DATE

o  Set Due Date for Mext Evaluation Set Date |

An electronic signature is required to complete the evaluation. Use the mouse to sign the Evaluatee Signature
and click the “Finished” button.

The Evaluation will not be entirely finished until both the Evaluatee and Evaluator have signed the form.

The Evaluator will set the “Date for the Next Evaluation” after both signatures have been finished.
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